# Table of Contents

Table of Contents.............................................................................................................................................. 2  
PowerPort-E.......................................................................................................................................................... 3  
Installation of PowerPort-E................................................................................................................................... 4  
Silent Installation.................................................................................................................................................. 5  
Uninstalling PowerPort-E....................................................................................................................................... 5  
Setting up the Connection PC - Device.................................................................................................................... 6  
Loading of Device Data When Using PowerPort-E................................................................................................. 17  
Restoring Device Data When Using PowerPort-E.................................................................................................. 18  
Backup and Documentation When Using PowerPort-E........................................................................................... 19  
Off-line Device Planning Via PowerPort-E............................................................................................................... 20  
PowerPort-E Keyboard Commands.......................................................................................................................... 21  
Measured Values.................................................................................................................................................... 22  
Acknowledgments.................................................................................................................................................. 23  
Status Display via PowerPort-E............................................................................................................................. 25  
Recorder.............................................................................................................................................................. 26  
Parameters........................................................................................................................................................... 31  
Device Parameters................................................................................................................................................ 38  
Graphical Display of Tripping Characteristics....................................................................................................... 40  
Programmable Logic.............................................................................................................................................. 43  
IEC61850*.......................................................................................................................................................... 44  
Remote Configuration for Line Differential Protection Devices*............................................................................... 46  

www.eaton.com
PowerPort-E

PowerPort-E is software that is used to configure a device and read data from a device. PowerPort-E provides the following:

- Menu controlled parameter setting including validity checks;
- Off-line configuration of all relay types;
- Reading and evaluation of statistical data and measuring values;
- Commissioning Support (Forcing Relays, Disarming Relays);
- Display of the device status; and
- Fault analysis via event and fault recorder.

**NOTICE**

PowerPort-E 3.0 or higher supports reading parameter files generated by older versions of PowerPort-E. Parameter files generated by PowerPort-E 3.0 and higher cannot be read by older versions of PowerPort-E.
Installation of PowerPort-E

**NOTICE** Port 52152 must not be blocked by a Firewall. If it is, the connection will be blocked.

**NOTICE** If the Windows User Access Control pops up while installing *PowerPort-E*, please "Allow" all installation requirements concerning *PowerPort-E*.

System requirements:

Windows 7, Windows 8.x or Windows 10

To install *PowerPort-E*:

- Double-click on the installation file with the left mouse button.
- Confirm by pressing the »Continue« button in the INFO frame.
- Select an installation path or confirm the standard installation path by mouse click on the »Continue« button.
- Confirm the entry for the suggested installation folder by mouse click on the »Continue« button.
- Start the installation process by mouse click on the »Install« button.
- Finish the installation procedure by mouse click on the »Complete« button.

If the suggested installation folder was chosen in the procedure above, the user can now call up the program via [Start > Programs > Eaton Relays> PowerPort-E].
Silent Installation

In some cases it is required to perform an unattended ("silent") installation. For example, an IT department might want to remotely install or upgrade PowerPort-E without the PC user being distracted by dialog windows.

The setup program features a special "silent" mode for this purpose, which is entered if command-line options are given as follows:

- `PowerPort-E_Install.exe /SILENT`
  
  This command performs a "silent" installation of all PowerPort-E-related applications including USB driver, and there is no user interaction needed for the installation process. However, the Installation Progress window is visible during the installation process.

- `PowerPort-E_Install.exe /VERYSILENT`
  
  This command performs a "very silent" installation of all applications related to PowerPort-E, including USB driver: There is no user interaction needed for the installation process, and no dialog or window is visible.

The SILENT and VERYSILENT options may be combined with another option, UNINSTOLD.

- `PowerPort-E_Install.exe /SILENT /UNINSTOLD`
- `PowerPort-E_Install.exe /VERYSILENT /UNINSTOLD`

In addition to the "silent" and "very silent" installation described above, it is checked whether there are any previous ("old") versions of PowerPort-E installed, and if this is the case then the previous version(s) are uninstalled (also in a "silent" manner, without any user interaction).

**NOTICE**

Note that additional preparations might be necessary to let the installation process run seamlessly; in particular, the "UAC" (User Access Control) dialog of the Windows operating system has to be managed via the "Microsoft System Center" and the "Microsoft Group Policy".

Uninstalling PowerPort-E

Via the [Start>System Control >Software] menu, the PowerPort-E application can be uninstalled from the computer.
Setting up the Connection PC - Device

Set up a Connection via a Serial Interface

After installation of the software, the »Connection PC/Notebook to the Device« has to be initially configured so that the User is able to read device data or re-write them into the device by means of the PowerPort-E application.

To connect the device to the User's PC/notebook, a special null modem cable is needed (no serial cable! - please refer to the section »Null Modem Cable«).

If the PC/notebook does not have a serial interface, the User will need a special USB-to-serial-adapter. If the USB-to-serial-adapter is correctly installed, communication with the device can be established using the CD provided (see the next section).

Setting Up/Configuring the Connection

- Connect your PC/notebook with the device via a null modem cable.
- Start the PowerPort-E application.
- Select the menu point »Device Connection« in the »Settings« menu.
- Click on »Serial Connection«.
- Select the serial interface (COM-Port) where the device shall be connected to.
- Confirm the adjustments by clicking the »OK« button.
- If the interface is chosen for the first time, a popup window will appear “The selected connection is currently not installed. Should this connection be used for device communication?”. Confirm this by pressing the “Yes” button.
Parameter Setting and Evaluation via Serial/RS232
Establishing the Serial Connection Via a USB-/RS232-Adapter

If your PC/notebook does not have an RS-232 interface, an USB-/RS232-Adapter+Null Modem Cable can be used.

**NOTICE**

Only an adapter approved by Eaton Corporation may be used. First install the adapter (with the related driver that you can find on the CD) and then establish the connection (PowerPort-E => Device). The adapters must support very high speed data transfer.

**USB/RS232 Cable Assemblies:**

<table>
<thead>
<tr>
<th>Style Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>66B2214G01</td>
<td>Null Modem Cable</td>
</tr>
<tr>
<td>66B2214G02</td>
<td>USB to RS232 Adapter</td>
</tr>
<tr>
<td>66B2214G03</td>
<td>Null modem and USB to RS232 Adapter</td>
</tr>
</tbody>
</table>
Set up a Connection Via Ethernet - TCP/IP

**WARNING**

Warning: Mixing up IP Addresses

(In case there is more than one protective device within the TCP/IP network or establishing an unintentional wrong connection to a protective device based on a wrong entered IP address.

Transferring parameters into the wrong protective device might lead to death, personal injury, or damage of electrical equipment.

In order to prevent faulty connections, the User MUST document and maintain a list with the IP addresses of any switchboard/protective devices.

The User MUST double check the IP addresses of the connection that is to be established. That means, the User MUST first read out the IP address at the HMI of the device (within menu [Device para/TCP IP]) then compare the IP address with the list. If the addresses are identical, establish the connection. If they are not, DO NOT establish the connection.

**NOTICE**

Establishing a connection via TCP/IP to the device is only possible if your device is equipped with an Ethernet Interface (RJ45).

Contact your IT administrator in order to establish the network connection.

*Part 1: Set the TCP/IP Parameters at the panel (Device).*

Call up the »Device parameter/TCP/IP« menu at the HMI (panel) and set the following parameters:

- TCP/IP address
- Subnet mask
- Gateway

*Part 2: Setting the IP address within PowerPort-E*

- Call up the menu Settings/Device Connection within PowerPort-E.
- Set the radio button Network Connection.
- Enter the IP-Address of the device that should be connected.
Parameter Setting and Evaluation via TCP/IP
Or:

**PowerPort-E**

Parameter Setting and Evaluation via TCP/IP
Set-up a Connection Via Modbus Tunnel

**NOTICE** Establishing a connection via a Gateway (TCP/IP)/Modbus RTU to the device is only possible if your device is equipped with an Ethernet Interface (RJ45).

Contact your IT administrator in order to establish the network connection.

*Part 1: If you don't know the Slave ID of the device that should be connected via Modbus Tunnel, it can be read out at the device.*

- Call up the menu »Device parameter/Modbus« at the HMI (panel) and read out the Slave ID:

*Part 2: Setting the IP address of the gateway and the Slave ID of the device that is to be connected via Modbus tunnel using PowerPort-E*

- Call up the menu Settings/Device Connection within PowerPort-E.
- Select »Modbus TCP/IP Gateway«
- Enter the IP-Address of the device that should be connected.
- Enter the Slave ID of the device.
- Enter the Modbus TCP Port (if a different is used as the standard port 502)
Parameter Setting and Evaluation via Modbus Tunnel
Setting up the connection via a USB Cable

- Please install PowerPort-E in case that it has not yet been installed on your PC.
- Connect your PC/notebook via a USB cable with a powered/running device.
- Start the software PowerPort-E.
- Select the menu point »Device Connection« in menu »Settings«.
- Within this menu select the communication option USB connection.
- Within the Drop-Down-Menu select the connected USB device.

If the interface is chosen for the first time, a pop-up window will appear “The selected connection is currently not installed. Should this connection be used for device communication?”. Confirm this by pressing the “Yes” button.
PowerPort-E Troubleshooting during Setting up the Connection

- Make sure that the Windows service *Telephony* is started. In [Start>System Control >Administration >Services] the service »Telephony« must be visible and must have been started. If not, the service has to be started.

- For establishing the connection, the User needs to have sufficient rights (administration rights).

- If a firewall is installed on your computer, TCP/IP port 52152 must have been released.

- If your computer does not have a serial interface, the User needs a *USB-to-serial-adapter*, approved by Eaton Corporation. This adapter has to be properly installed.

- Ensure that a null modem cable is used (a standard serial cable without control wires does not enable communication).
PowerPort-E Persistent Connection Problems

In the case of persistent connection problems, the User should remove all connection settings and establish them again. In order to remove all connection settings, please proceed as follows.

1. **Remove the Settings for the Dial-up Network.**

- Close PowerPort-E.
- Call up the »Control Panel«.
- Choose »Network & Internet«.
- On the left side, click on »Manage Network Connections«.
- Right click on »Eaton Relays Direct Connection«.
- Choose »Delete« from the shortcut menu.
- Click on the »OK« button.

2. **Remove the (Virtual) Modem.**

- Call up the »Control Panel«.
- Choose »Hardware & Sound«.
- Choose »Phone & Modem Options«.
- Go to the »Modem« tab.
- Click on the correct (in case there is more than one) entry »Connection cable between two computers«.
- Click on the »Remove« button.
Connected to the Device and Calling up Websites at the same Time*

*=applies to serial connections only (RS232)

In principle, it is possible to call up websites while there is an active connection to the device.

If your computer has no direct connection to the internet, that means, that it is placed behind a proxy server, the device connection has to be modified in certain circumstances. The device connection has to be provided with the proxy settings.

Example: Internet Explorer

For each connection the proxy settings have to be set manually. Please proceed as follows:

- Start your Internet Explorer.
- Call up the »Tools« menu.
- Call up the menu »Internet options«.
- Call up the tab »Connections«.
- Click with the left hand mouse key on the button »Settings« on the right of the »Eaton Relays Direct Connection«.
- Set the check box »Use Proxy Server for this connection.«
- Enter the proxy settings that are available by your network administrator.
- Confirm the settings by pressing »OK«.

Firefox

The proxy settings are centrally managed, so there is no need to modify any settings.

Loading of Device Data When Using PowerPort-E

- Start the PowerPort-E application.
- Make sure the connection has been established properly.
- Connect your PC with the device.
- Select »Receiving Data From The Device« in the »Device« menu.
Restoring Device Data When Using PowerPort-E

**WARNING**

By selecting the »Transfer only modified parameters into the device« button, only modified parameters are transmitted into the device.

Parameter modifications are indicated by a red "star symbol" in front of the parameter.

The star symbol (in the device tree window) indicates that parameters in the opened file (within PowerPort-E) differ from parameters stored on your local hard disk.

By selecting the »Transfer only modified parameters into the device« button, the User can transmit all parameters that are marked by this symbol.

If a parameter file is saved on the local hard drive, these parameters are no longer classified to be modified and cannot be transmitted via the »Transfer only modified parameters into the device« button.

In case the User has loaded and modified a parameter file from the device and saved it to the local hard drive without transferring the parameters into the device beforehand, the User cannot use the »Transfer only modified parameters into the device« button. In this case, use the »Transfer all parameters into the device« button.

**NOTICE**

The »Transfer only modified parameters into the device« button only works if modified parameters are available in the PowerPort-E application.

In contrast, all parameters of the device are transferred when the »Transfer all parameters into the device« button is pressed (provided all device parameters are valid).

- In order to (re-)transfer changed parameters into the device, select »Transfer all parameters into the device« in the »Device« menu.
- Confirm the safety inquiry »Shall the parameters be overwritten into the device?«.
- Enter the password for setting parameters in the pop-up window.
- The changed data is transferred to the device and adopted.
- Confirm the message »Parameters successfully updated«. It is recommended to save the parameters into a local file on your hard drive. Confirm »Shall The Data Be Saved Locally?« with »Yes« (recommended). Select a suitable folder on the hard disk.
- Confirm the chosen folder by clicking »Save«.
- The changed parameter data are now saved in the chosen folder.
Backup and Documentation When Using PowerPort-E

How to Save Device Data on a PC

Click on »Save as ...« in the »File« menu. Specify a name, choose a folder on the hard disk, and save the device data accordingly.

Printing of Device Data When Using PowerPort-E (Setting List)

The »Printing« menu offers the following options:

- Printer settings;
- Page preview;
- Printing; and
- Exporting the selected print range into a "txt" file.

The printing menu of the PowerPort-E software offers different types of printing ranges.

- **Printing of the complete parameter tree:**
  All values and parameters of the present parameter file are printed.

- **Printing of the displayed working window:**
  Only the data shown on the relevant working window are printed (i.e.: this applies, if at least one window is opened).

- **Printing of all opened working windows:**
  The data shown on all windows are printed (i.e.: this applies only if more than one window is opened).

- **Printing of the device parameter tree as from a shown position on:**
  All data and parameters of the device parameter tree are printed as from the position/marking in the navigation window. Below this selection, the complete name of the marking is additionally displayed.

Exporting Data as a “txt” File Via PowerPort-E

Within the print menu [File>Print], the User can choose »Export into File« in order to export the device data into a “txt” file.

**NOTICE**

When exporting data, only the actual selected printing range will be exported into a “txt” file. That means that if the User has chosen the "Complete device parameter tree" printing range, then the "Complete device parameter tree" will be exported. But, if the User has chosen the "Actual working window" printing range, only that range of data will be exported.

This is the only method available to export data via PowerPort-E.

**NOTICE**

If the User exports a “txt” file, the content of this file is encoded as Unicode. That means that, if the User wants to edit this file, the application must support Unicode encoded files (e.g.: Microsoft Office 2003 or higher).
Off-line Device Planning Via PowerPort-E

In order to be able to transmit a parameter file (e.g.: created off-line) into the device, the following information must be located:

- Type code (written on the top of the device/type label); and
- Version of the device model (can be found in menu [Device Parameters\Version].

The PowerPort-E application also enables the User to create a configuration/parameter file off-line using a "Device Model". The advantage of using a device model is that the User can pre-configure a device by setting parameters in advance.

The User can also read the parameter file out of the device, further process it off-line (e.g.: from the office) and finally re-transfer it to the device.

The user can either:

- Load an existing parameter file from a device (please refer to the Section "Loading Device Data When Using PowerPort-E");
- Create a new parameter file (see below); or
- Open a locally saved parameter file (backup).

In order to create a new device/parameter file by way of a device template off-line.

- In order to create a new off-line parameter file, select »Create new parameter file« within the »File« menu.
- A working window pops- up. Please make sure that you select the right device type with the correct version and configuration.
- Finally click on »Apply«.
- In order to save the device configuration, select »Save« out of the »File« menu.
- Within the »Modify Device Configuration (Typecode)« menu, the User can modify the device configuration or simply find out the type code of the current selection.

If the User wants to transfer the parameter file into a device, please refer to Section “Restoring Device Data When using PowerPort-E".

www.eaton.com
PowerPort-E Keyboard Commands

You can control PowerPort-E alternatively by means of keyboard commands (instead of the mouse)

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>↑</td>
<td>Moving up within the navigation tree or parameter list.</td>
</tr>
<tr>
<td>↓</td>
<td>Moving down within the navigation tree or parameter list.</td>
</tr>
<tr>
<td>←</td>
<td>Collapse the tree item or select a folder on a higher level.</td>
</tr>
<tr>
<td>→</td>
<td>Expands the tree item or selects a subfolder.</td>
</tr>
<tr>
<td>Numpad +</td>
<td>Expands the tree item.</td>
</tr>
<tr>
<td>Numpad −</td>
<td>Collapses the tree item.</td>
</tr>
<tr>
<td>Home</td>
<td>Moves to the top of the active window.</td>
</tr>
<tr>
<td>End</td>
<td>Moves to the bottom of the active window.</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Opens the file opening dialog. Browsing through the file system for an existing device file.</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Creates a new parameter file file by means of a template.</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Saves actual loaded parameter file.</td>
</tr>
<tr>
<td>F1</td>
<td>Displays the online help information.</td>
</tr>
<tr>
<td>F2</td>
<td>Load Device Data</td>
</tr>
<tr>
<td>F5</td>
<td>Reloads the displayed data of a device.</td>
</tr>
<tr>
<td>Ctrl+F5</td>
<td>Enables automatic refresh.</td>
</tr>
<tr>
<td>Ctrl+Shift+T</td>
<td>Back to the navigation window.</td>
</tr>
<tr>
<td>Ctrl+F6</td>
<td>Walks through the tabular forms (detail windows).</td>
</tr>
<tr>
<td>Page ↑</td>
<td>Previous value (parameter setting).</td>
</tr>
<tr>
<td>Page ↓</td>
<td>Next value (parameter setting).</td>
</tr>
<tr>
<td>Ctrl+Shift+Alt+S</td>
<td>Switches on/off the service info mode, which displays additional service information.</td>
</tr>
</tbody>
</table>
Measured Values

Read Out of Measured Values Via PowerPort-E

• If PowerPort-E is not running, please start the application.

• If the device data have not been loaded, select »Receive Data From The Device« from the »Device« menu.

• Double click on the »Operation« icon in the navigation tree.

• Double click on the »Measured Values« icon within the »Operation« navigation tree.

• Double click the »Standard Values« or »Special values« within the »Measured values« tree.

• The measured and calculated values are now shown in tabular form in the window.

NOTICE To have the measuring data read in a cyclic manner, select »Auto refresh« in the »View« menu. The measured values are read out about every two seconds.
Acknowledgments

Manual Acknowledgment Via PowerPort-E

- If PowerPort-E is not running, please start the application.
- If device data have not been downloaded recently, select »Receive Data From The Device« from the »Device« menu.
- Double click on the »Operation« icon in the navigation tree.
- Double click on the »Acknowledgment« icon within the operation menu.
- Double click the entry within the pop-up that is to be acknowledged.
- Press the »Execute immediately« button.
- Confirm the question if the changes should be executed by »Yes«.
- Enter the password.

External Acknowledge Via PowerPort-E

If PowerPort-E is not running, please start the application.

- If device data have not been downloaded recently, select »Receive Data From The Device« from the »Device« menu.
- Double click on the »Device Parameter« icon in the navigation tree.
- Double click on the »Ex Acknowledge« icon within the operation menu.
- In the working window, the User can now assign each signal that resets all acknowledgeable LEDs, a signal that resets all Relay Outputs, a signal that resets the SCADA signals respectively, and a signal that acknowledges a pending trip command.
Manual Resets Via PowerPort-E

- If PowerPort-E is not running, please start the application.
- If device data have not been downloaded recently, click »Receive Data From The Device« in the »Device« menu.
- Double click the »Operation« icon in the navigation tree.
- Double click the »Reset icon« within the operation menu.
- Double click the entry within the pop-up that is to be reset or deleted.

**NOTICE** The description of the reset commands can be found within the corresponding modules.
Status Display via PowerPort-E

- If PowerPort-E is not running, please start the application.
- If the device data have not been downloaded recently, select »Receive Data From The Device« from »Device« menu.
- Double click on the »Operation« icon in the navigation tree.
- Double click on the »Status Display« icon within the operational data.
- Double click on a subfolder (e.g. Prot) in order to see e.g. the states of the general alarms.

**NOTICE**
To have the status display updated in a cyclic manner, select »Automatic Update« in the »View« menu.

<table>
<thead>
<tr>
<th>State of the Module Input / Signal Is...</th>
<th>Is Shown in PowerPort-E as...</th>
</tr>
</thead>
<tbody>
<tr>
<td>false / »0«</td>
<td>0</td>
</tr>
<tr>
<td>true / »1«</td>
<td>1</td>
</tr>
<tr>
<td>No connection to the device</td>
<td>?</td>
</tr>
</tbody>
</table>
Recorder

Waveform Recorder

To Read Out the Waveform Recorder with PowerPort-E

- If PowerPort-E is not running, please start the application.
- If the device data have not been loaded, click »Receive Data From The Device« in the »Device« menu.
- Double click the »Operation« icon in the navigation tree.
- Double click the »Recorders« icon in the navigation tree.
- Double click the »Waveform rec« icon.
- In the window, the waveform records are shown in tabular form.
- A pop-up will appear by double clicking on a waveform record. Choose a folder where the waveform record is to be saved.
- The User can analyze the waveform records by means of the optionally available Quality Manager by clicking on »Yes« when asked "Shall the received waveform record be opened by the Quality Manager?"

Deleting Waveform Records Via PowerPort-E

- If PowerPort-E is not running, please start the application.
- If the device data have not been loaded, click »Receive Data From The Device« in the »Device« menu.
- Double click the »Operation« icon in the navigation tree.
- Double click the »Recorders« icon in the navigation tree.
- Double click the »Waveform rec« icon.
- In the window, the waveform records are shown in tabular form.
- In order to delete a waveform record, double click on (the red x) in front of the waveform record and confirm.
Fault Recorder

How to Read Out the Fault Recorder Via PowerPort-E

- If *PowerPort-E* is not running, please start the application.
- If the device data have not been loaded, click »Receive Data From The Device« in the »Device« menu.
- Double click the »Operation« icon in the navigation tree.
- Double click the »Fault Rec« icon within the »Operation/Recorders« tree.
- In the window, the fault recordings are shown in tabular form.
- In order to receive more detailed information on a fault double click the selected item in the list.

**NOTICE**

Via the print menu you can export the data into a file. Please proceed as follows:

- Call up the data as described above.
- Press the »Export to File« button.
- Enter a file name.
- Choose a location where to save the file.
- Confirm the »Save« button.
Trend Recorder

Functional Description

The Trend Data are data points stored by the Trend Recorder on the relay device over fixed intervals of time, and can be downloaded from the device using PowerPort-E. A Trend Record is viewable using the Quality Monitor software by selecting files saved by PowerPort-E with a file extension of “.ErTr”. The list of available trend recorder data is viewable by selecting [Operation/ Recorders/Trend Recorder] on the front panel of the relay.

When viewed within the Quality Manager, the trend record will show the observed values (up to 10) that the User has specified. The available values are dependent on the ordered protective device. The Trend Recorder has a storage capacity of max. 4000 entries.

Managing Trend Records

To download information from the Trend Recorder, select [Operation/Recorder/Trend Rec] from the menu tree. The User will find three options within the Trend Recorder window that will allow the User to:

- Receive Trend Records,
- Refresh the Trend Recorder, and
- Delete Trend Records.

Selecting the »Receive Trend Record« button will download data from the relay to the User's PC. By selecting the »Refresh Trend Recorder«, PowerPort-E updates the list of the Trend Recorder. The »Delete Trend Recorder« function will clear all trend data from the relay, leaving the data files on the User's PC.

To view data using the Quality Manager, first the User must open the desired “.ErTr” file to be viewed from a folder location previously designated by the User. Once the “.ErTr” file is open, the User will see the “Analog Channels” that are monitored by the Trend Recorder. By clicking on the “Analog Channels”, all monitored parameters are listed. To view a channel, the User must click on the left mouse key, then drag and drop the channel onto the right side of the Quality Manager screen. The channel is then listed under the »Displayed Channels«.

To remove a channel from view, the User must select the Trend Data to be removed in the »Displayed Channels« menu tree, then click on the right mouse button to bring up the menu options. Here, the User will find the »Remove« menu option that, when selected, will remove the trend data.
Event Recorder

To Read Out the Event Recorder via PowerPort-E

- If *PowerPort-E* is not running, please start the application.
- If the device data have not been loaded, click »Receive Data From The Device« in the »Device menu.
- Double click the »Operation« icon in the navigation tree.
- Double click the »Event Rec« icon within the »Operation/Recorders« menu.
- In the window, the events are shown in tabular form.

**NOTICE**

To have the event recorder updated in a cyclic manner, select »Automatic Update« in the »View« menu.

*PowerPort-E* is able to record more events than the device itself, if the window of the event recorder is opened and »Automatic Update« is set to active.

**NOTICE**

Via the print menu you can export the data into a file. Please proceed as follows:

- Call up the data as described above.
- Call up the menu [File/Print].
- Choose »Print Actual Working Window« within the popup.
- Press the »Print« button.
- Press the »Export to File« button.
- Enter a file name.
- Choose a location where to save the file.
- Confirm the »Save« button.
Check Self-Supervision Messages via Power-Port-E

This feature is available only when connecting with a recent E-Series protection device.

The protection device supervises its own functionality by constantly performing various self-tests. If it detects any serious problem, or any event that has a serious impact on the operation of the device then this event is recorded.

The menu [Operation / Self Supervision / Messages] gives access to this list of internal messages. The following data is part of each entry:

- **Record Number** – a counter without special meaning
- **Date of Record** – timestamp of the event
- **Message** – a message ID with a (short, heavily abbreviated) message text
- **Value** – additional data specific to the event

All messages that can potentially appear here are described in detail in a separate document, the “E-Series Troubleshooting Guide”.

Parameters

Changing Passwords via Power-Port-E

Download the parameter file from the device.

- Passwords can be changed by a double-click within menu [Device Para\Password\Change Password] on the corresponding password.
- Enter the old password and the new password twice
- Confirm the changes by a click on »OK«.

Parameter Setting via Power-Port-E

Power-Port-E shows within the windows, where parameters are edited also the required access level for the parameters and settings. The required access authorizations will be verified when the parameter file should be transferred into the protective device. For the transmission, two options are available.

1. The transfer of all Parameters. This always requires the Supervisor (administrator) password.

2. The transfer of the modified Parameters only. It has to be taken into account, the passwords that are required by this are determined by those parameters, that require the highest passwords (access authorizations).

Example 1:
A »Prot-Lv1«-parameter and a »Prot-Lv2« parameter have been edited and should be transferred. The User will be asked for the »Prot-Lv2« password.

Example 2:
A »Prot-Lv1« parameter and a »Prot-Lv2« parameter and a device planning parameter have been changed and should be transferred. The User will be asked for the »Supervisor-Lv3« password.

Example 3:
A »Prot-Lv1« parameter and a »Prot-Lv2« parameter as well as a »Ctrl-Lv2« parameter have been changed and should be transferred. The User will be asked for the »Prot-Lv2« and the »Ctrl-Lv2« password.
Changing of Parameters when using the Power-Port-E - Example

Example: Changing of a protective parameter (to alter the characteristic for the overcurrent protection function I[1] in parameter set 1).

- In case Power-Port-E is not in operation – start this software.
- In case the device data has not been loaded – select »Data To Be Received From The Device« in menu »Device«.
- Double-click the »Protection Para Set Icon« in the navigation tree.
- Double-click the »Set 1 Icon« in the navigation tree.
- Double-click the »protection stage I[1]« in the navigation tree.
- In the working window a tabulated overview appears, showing the parameters assigned to this protective function.
- In this table double-click the value/parameter you want to change (here: »Char«).
- Another window (popup) is opened where you can select the required characteristic.
- Close this window by clicking the »OK« key.

**NOTICE**

A star symbol in front of the changed parameters indicates that the alterations have only been saved temporarily. They are not yet finally stored and adopted by the software/device.

In order to make things easier to follow, especially where complex parameter changes are involved, on every superior/higher menu level, the intended change of the parameter is indicated by the star symbol (star trace). This makes it possible to control or follow up from the main menu level at any time where parameter changes have been made and have not been saved finally.

**NOTICE**

Plausibility check: In order to prevent obvious wrong settings the software monitors constantly all temporary saved parameter changes. If it detects an implausibility, this is indicated by a question mark in front of the respective parameter.

In order to make things easier to follow up, especially where complex parameter changes are involved, on every superior/higher menu level above of the temporary saved parameters, an implausibility is indicated by a question mark (plausibility trace). This makes it possible to control or follow from the main menu level at any time where implausibilities exist.

So it is possible to see from each point of the menu tree that implausibilities have been detected by the software.

A star/parameter change indication is always overwritten by the question mark/implausibility symbol.

If the software detects an implausibility it rejects saving and adopting of the parameters.
Additional parameters can be changed if required.

There are two options available to transfer changed parameters into the device within menu »Device«.
1. »Transfer all Parameters into the Device«. This always requires the Supervisor (administrator) password.
2. »Transfer only modified parameters into the Device«. For this parameter transfer the User needs passwords that provide sufficient access authorization for all parameters that are to be transferred.

Confirm the safety inquiry »Shall The Parameters Be Overwritten?«.

Enter the password for setting parameters in the popup window.

Confirm the inquiry »Shall The Data Be Saved Locally?« with »Yes« (recommended). Select a suitable storing location on your hard disk.

Confirm the chosen storing location by clicking »Save«.

The changed parameter data is saved now in the data file chosen by you. Thereafter the changed data is transferred to the device and adopted.

**NOTICE**

Once you have entered the parameter setting password, Power-Port-E wont ask you again for the password for 10 minutes at least. This time interval will start again, each time parameters are transmitted into the device. If for more than 10 minutes no parameters are transmitted into the device, Power-Port-E will ask you again for the password, when you are trying to transmit parameters into the device.
Setting Groups

Setting Group Switch Via PowerPort-E

- If PowerPort-E is not running, please start the application.
- If the device data have not been loaded, click »Receive Data From The Device« in the »Device« menu.
- Double click the »Protection Para« icon in the navigation tree.
- Double click the »P-Set Switch« within the protection parameters.
- To configure the Setting Group Switch respectively, manually choose an active set.

**NOTICE**
The description of the parameters can be found within the "System Parameters" section.
Copying Setting Groups (Parameter Sets) Via PowerPort-E

NOTICE Setting groups can only be copied if there are no conflicts (no red question marks).

For applications using multiple settings groups, one can use the configuration file from the first group to create the second group. With the help of PowerPort-E, the User can simply copy an existing setting group to another (not yet configured) one. The User only needs to change those parameters where the two setting groups are different.

To efficiently establish a second parameter set where only few parameters are different, proceed as follows.

- If PowerPort-E is not running, please start the application.
- Open a (off-line) parameter file of a device or load data of a connected device.
- Carefully save the relevant device parameters by selecting [File\Save as].
- Select »Copy Parameter Sets« out of the “Edit” menu.
- Then define both source and destination of the parameter sets to be copied (source = copy from; destination: copy to).
- Click on »OK« to start the copy procedure.
- The copied parameter set is now cached (not yet saved!).
- Then, modify the copied parameter set(s), if applicable.
- Assign a new file name to the revised device parameter file and save it on your hard disk (backup copy).
- To transfer the modified parameters back to the device, click on the »Device« menu item and select »Transfer All Parameters into the Device«.
Comparing Setting Groups Via PowerPort-E

- If PowerPort-E is not running, please start the application.
- Click on menu item »Edit« and select »Compare Parameter Sets«.
- Select the two parameter sets from the two drop down menus that are to be compared with each other.
- Press the »Compare« button.
- The values that are different from the set parameters will be listed in tabular form.

Comparing Parameter Files Via PowerPort-E

With the help of PowerPort-E, the User can simply compare/differentiate the currently open parameter/device file against a file on the hard disk. The precondition is that the versions and type of devices match. To compare the parameter files, please proceed as follows.

- Click on »Compare with a Parameter File« within the »Device« menu.
- Click on the Folder icon in order to select a file on your hard disk.
- The differences will be shown in tabular form.
Converting Parameter Files Via PowerPort-E

Parameter files of the same type can be converted. During this process, the new parameter file will keep all active settings from the source parameter file and, at the same time, remove all inactive settings. As many parameters as possible will be converted.

- Parameters that are newly added will be set to default.
- Parameters that are not included in the target file version will be deleted.
- In order to convert a parameter file please proceed as follows.
- If PowerPort-E is not in operation, please start the application.
- Open a parameter file or load the parameters from a device that should be converted.
- Make a backup of this file in a fail-safe place.
- Choose »Save as« from the »File« menu.
- Enter a new file name (in order to prevent overwriting the original file).
- Choose the new file type from drop down menu »File Type«.
- Confirm the security check by clicking on »Yes« only if the User is sure that the file conversion should be executed.
- In tabular form the modifications will be shown as follows.

<table>
<thead>
<tr>
<th>Added parameter:</th>
<th>![Symbol]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted parameter:</td>
<td>![Symbol]</td>
</tr>
</tbody>
</table>
Device Parameters

Assignment of Digital Inputs

There are two options available in order to determine where a Digital Input should be assigned to.

**Option 1**
- Assigning a Digital Input onto one or multiple modules.

*Adding an assignment via Power-Port-E*
Within menu [Device Parameter\Digital Inputs] Digital Inputs can be assigned onto one or multiple targets. Call up the Digital Input (double click on the DI) and select the assignment that has to be added. By means of clicking on »add« the assignment will be shifted from the list of available to the list of used assignments.

*Deleting an assignment: via Power-Port-E*
Call up the assignments (double click on the DI within the Software) and select the assignment that is to be deleted. The assignment will be deleted from the list of used assignments by means of clicking on »remove«

**Option 2** – Connecting a Module Input with a Digital Input

Call a module. Within this module assign a Digital Input onto a module input. Example: A protection module should be blocked depending on the state of a Digital Input.. For this assign onto the blocking input within the Global Parameters the Digital Input (e.g. Ex Blo 1).
Checking the Assignments of a Digital Input

In order to check the targets that a Digital Input is assigned to please proceed as follows:

Call up menu [Device Parameter\Digital Inputs].

Navigate to the Digital Input that should be checked.

Via PowerPort-E view

All targets of a Digital Input will be shown, listed and separated by a semicolon behind a Digital Input. Please note that the window might be too small and thus hide some targets. All assignments can be seen by means of a double click onto a Digital Input. Within this window also further assignments can be done.

Synchronize Date and Time Via PowerPort-E

- If PowerPort-E is not running, please start the application.
- If device data have not been downloaded recently, click »Receive Data From The Device« in the »Device« menu.
- In the device tree, navigate to the entry »Date and Time«, which is in the menu branch [Device parameters / Time], and double-click this entry.
- A dialog opens that show the current date and time of both PC and protective device. (A checkbox allows to toggle the timezone between local and UTC; however, see also the note below.)
- Click on the button “Synchronize”. You will be asked for the password of access level “Supervisor-Lv3”.
- The protective device receives and takes over date and time from the PC.

PowerPort-E in connection with a recent E-series device is able to consider that the timezone settings might be different on PC and device.

This is not possible in case of a connection with an older device, so that there is the risk of ending up with a wrong time setting. Therefore it is recommended in case of an older protective device to first set the device to the same timezone as the PC and only afterwards synchronize date and time.

If you are unsure whether your connection supports this timezone check: If the checkbox for toggling between UTC and local timezone is visible in the dialog mentioned above then the timezone check is supported.

Version Via PowerPort-E

Within the »File/Properties« menu, the User can obtain detailed information on the currently opened file (e.g.: software and hardware version).

In order to be able to transmit a parameter file (e.g.: created off line) into the device, the following parameters must agree:

- Type Code (written on the top of the device/type label); and
- Version of the device model (can be found in the »Device Parameters\Version« menu).
Graphical Display of Tripping Characteristics

The application supports the graphical display of tripping characteristics. Depending on the device type and the device configuration various tripping characteristics and related characteristics can be displayed.

- Overcurrent Tripping Characteristics (ANSI, IEC,...)
- Tripping areas of the underexcitation protection
- Switchgear-Wear-Curves

Example – Graphical Visualization of the Overcurrent Tripping Characteristic 50P[1]

- If the device data/parameters are not loaded yet, please load them from the device or open a file.
- Navigate within the device parameter tree into menu [Protection Para / Set 1 / I-Prot / 50P[1]].
- Double-click on element 50P[1].
- The window that pops up will show all those parameters in tabular form that are tied to this protective element and that define among others the tripping characteristic.
- Click on the icon »View Characteristic« within the command line of the window.

- An additional window will show now the graphical visualization of the selected tripping characteristic.
Adding and removing tripping characteristics to the visualization

Additional tripping characteristics of further protective elements and protection sets can be added to the visualization.

Example: Adding additional Curves to the Visualization of the Tripping Characteristic I[1]
- Open, as described in the example above, the window for the visualization of the tripping characteristic of the protective element I[1].
- Click within the menu bar of this working window on the icon »Add/Remove Curves...«

- A selection window pops up. Select please:
  - Which protective elements should be displayed additionally.
    (Only available, if more than one protective element of the same type is projected.)
  - Which parameter sets should be shown additionally in this visualization.
    (Only available, if this protective element is available in multiple parameter sets.)
- Select those curves, that should be shown in addition to the current visualization.
- Close the selection window by a click on »Apply«.
- The graphical visualization is now being updated. And the additionally selected curves will be shown.
Selection of related curves

Related curves (e.g. reset curves, voltage restrained overcurrent curves,...) can be displayed, the availability is depending on the device and configuration.

Example: Visualization of the Reset Curve for Overcurrent Element 50P[1]

- Open as described in the example above, the working window for the visualization of the tripping characteristic of the overcurrent element 50P[1].

- There is a drop down menu within the the upper menu bar of this working window. This can be used in order to select related curves as:
  - Tripping characteristics
  - Reset curves
  - Voltage restrained overcurrent protection curves

- Select within the drop down menu »Reset curve«

- The the working window will be updated. Now the »Reset Curve« will be shown instead of the »Tripping Curve«.
Programmable Logic

Programmable Logic Via PowerPort-E

**WARNING** Improper use of logic equations might result in personal injury or damage the electrical equipment.

Do not use logic equations unless the User can ensure the safe functionality.

**NOTICE** It is recommended to configure the logic via the PowerPort-E application.

*How to configure a logic equation?*

- Within the Device Planning, set the number of required Logic Equations.
- Call up the [Logic] menu.
- Set the Input Signals (where necessary, invert them).
- If required, configure the timer (»On delay« and »Off delay«).
- If the latched output signal is used, assign a reset signal to the reset input.
- Within the »status display«, the User can check the status of the logical inputs and outputs of the logic equation.

In case the logic equations should be cascaded, the User has to be aware of timing delays (cycles) in case of descending sequences (Please refer to section: Cascading Logical Outputs).

By means of the Status Display [Operation/Status Display], the logical states can be verified.
IEC61850*

*=only available in devices that offer this protocol.

**Generation/Export of a device specific ICD file**

Each device of the E-Series includes a description of its own functionality and communications skills in form of an *.ICD file (IED Capability Description). This file can be exported as follows and be used for the configuration of the substation.

**NOTICE**

- A change of the devices parameters has an influence on the content of the ICD file.

1. Connect the device with your PC/Notebook.
2. Start PowerPort-E.
3. Click on »Receive data from Device« in the menu »Device«.
4. Click on »IEC61850« in the menu »Device Para«.
5. Click on the ICD icon in the IEC61850 window.
6. Select a drive and file name for the ICD file and click "save".
7. Repeat the steps 1 to 6 for all connected devices in this IEC61850 environment.

**Generation/Export of a SCD file**

Each device of the E-Series can create an export its own functionality and communications skills in form of a *.SCD file.

1. Connect the device with your PC/Notebook.
2. Start PowerPort-E.
3. Click on »Receive data from Device« in the menu »Device«.
4. Click on »IEC61850« in the menu »Device Para«.
5. Click on the SCD icon in the IEC61850 window.
6. Select a drive and file name for the SCD file and click "save".
7. Repeat the steps 1 to 6 for all connected devices in this IEC61850 environment.
Import of the .SCD file into the device

When the substation configuration is completed, the .SCD file has to be transmitted to all connected devices. This is has to be done as follows:

1. Connect the device with your PC/Notebook.
2. Start PowerPort-E.
3. Click on »Receive data from Device« in the menu »Device«.
4. Click on »IEC61850« in the menu »Device Para«.
5. Switch the parameter »IEC61850 Communication« to »OFF« and submit the changed parameter set into the device.
6. Click on the IEC icon in the IEC61850 window.
7. Select the folder, where the .SCD file is stored. Select the .SCD file and click "open".
8. The file will now be checked.
9. The configuration can now be transmitted into the device if no internal fault can be detected. Press button "Send config".
10. Now a password is requested. Enter the same password, which you use for parameter setting of the device.
11. Acc. to step 5 switch on again the IEC Communication and submit the changed parameter set into the device.
12. Repeat the steps 1 to 11 for all devices connected to this IEC61850 environment.
13. If no error message occurs, the configuration has been completed successfully.

**WARNING**

- When changing the substation configuration, usually a new .SCD file has to be generated. This .SCD file has to be mandatory transmitted to all devices by means of PowerPort-E. For the case, that this step will be forgotten, IEC61850 malfunctions will be the result

- Provided that parameters of the devices are changed after the substation configuration completion, changes in the corresponding .ICD file may result – this in turn may make an update of the .SCD file necessary.
Remote Configuration for Line Differential Protection Devices*

*only available in E-Series devices with Line Differential Protection.

In case of two interconnected Line Differential Protection devices, PowerPort-E also allows the configuration of the remote device.

**NOTICE** The "remote access" feature of the local Line Differential Protection device has to be set to active.

**NOTICE** The communication with the remote device uses the TCP/IP port 52160 (in addition to port 52152); therefore these ports must not be blocked by a firewall.

1. Connect the local device with your PC/Notebook.
2. Start PowerPort-E.
3. Click on »Receive data from Device« in the menu »Device«.
4. After the connection has been established a selection dialog for the local or remote device appears.
5. In this selection dialog choose »Remote Device«.
6. The data will then be loaded from the remote device.

The device data tree in PowerPort-E is marked with a yellow frame whenever data of the remote device is displayed.
This instruction leaflet is published solely for information purposes and should not be considered all-inclusive. If further information is required, you should consult an authorized Eaton sales representative.

The sale of the product shown in this literature is subject to the terms and conditions outlined in appropriate Eaton selling policies or other contractual agreement between the parties. This literature is not intended to and does not enlarge or add to any such contract.

The sole source governing the rights and remedies of any purchaser of this equipment is the contract between the purchaser and Eaton. NO WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE OR MERCHANTABILITY, OR WARRANTIES ARISING FROM COURSE OF DEALING OR USAGE OF TRADE, ARE MADE REGARDING THE INFORMATION, RECOMMENDATIONS, AND DESCRIPTIONS CONTAINED HEREIN. In no event will Eaton be responsible to the purchaser or user in contract, in tort (including negligence), strict liability or otherwise for any special, indirect, incidental or consequential damage or loss whatsoever, including but not limited to damage or loss of use of equipment, plant or power system, cost of capital, loss of power, additional expenses in the use of existing power facilities, or claims against the purchaser or user by its customers resulting from the use of the information, recommendations and description contained herein.